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General Notes

1.1

1.2

1.3

SIKO  AGOS

General Notes

Trademarks

All trademarks or brand names including those protected for third parties shall
unconditionally be subject to the provisions of the applicable laws governing trademarks and
the proprietary rights of the registered owners. All trademarks, brand names or firm names are
or may be trademarks or registered trademarks of their respective proprietors and are used
only for description and unique identification. All rights not explicitly granted here are
reserved.

Failure to explicitly identify trademarks used in this manual does not indicate that a name is
free from rights of third parties.

Windows®, Windows® XP are trademarks of Microsoft® Corporation in the USA and other
countries.

Anybus® is a registered trademark of HMS Industrial Networks AB, Sweden, USA, Germany and
other countries.

SIMATIC® TIA Portal® and $7-300®, S7-400®, S7-1200®, S7-1500® are registered trademarks
of Siemens AG.

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS and
PROFINET International (PI).

Liability

SIKO GmbH assumes no warranty whatsoever regarding topicality, correctness, completeness
or quality of the information or software products provided. All liahility claims against

SIKO GmbH referring to material or immaterial damages caused by using or not using the
information or software provided or by using erroneous or incomplete information or software
are always excluded.

Limitations
The library and its function were tested with SIMATIC® S7-300 CPU 6ES7 313-6CE01-0ABO.
The interface module was engineered in STL using SIMATIC® Manager V5.5 + SP3.

The configuration file and its function were tested on an Anybus® Communicator™ AB7000.
The file was setup using Anybus® Configuration Manager - Communicator RS232/422/485
version v.4.4.1.3 (Win 2000/XP/Vista/7).
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General Notes

1.4 Requirements

e Basic knowledge of handling and programming Siemens systems.
e Familiarity with PROFIBUS®.
e Basic knowledge of setup and handling Anybus® Communicator™

e Familiarity with Anybus® Configuration Manager

1.5 Versions Overview

This manual is related to
e AGO5 firmware version >= 1.02
Library “SIKO_SN5-PBvABC_LIB_V501”
Know-how protected function block FB205 “SIKO_DRV_AGO5vPB”
Anybus® configuration file “SIKO_PB_20-SN5_pattern”

Anybus® Communicator™ file “HMSB1803.gsd”

1.6 List of Abbreviations
FPB PROFIBUS® ABC  Anybus® Communicator™
SN5 SIKONETZ-5 ACM  Anybus® Configuration Manager
SW Status Word FB Function Block
cw Control Word DB Data Block
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Hardware Configuration

2 Hardware Configuration

2.1 Setup of Anybus® Communicator™
Please note, that the Anybus® configuration file is designed for a flexible SN5 participant

numbers of minimum 1 to maximum 20. Later node address has to be modified according to
your network requirements. Please consider a FPB address modification when reading further

on.

2.1.1 ABC Configuration File

Start ACM and select configuration file “SIKO_PB_20-SN5_pattern” from the folder
“Anybus Config”.
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2.1.2 Transfer Configuration

Connect ABC with PC via “RS232 configuration cable” of Anybus accessories.
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Hardware Configuration

1. Press “Connect” to go online with the ABC.

2. Press “download to the ABC”.

You should have the following view:
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2.1.3 ABC Cycle Time

Each transaction consists of “Query” and “Response”. The minimum time for a used
transaction is about >= 10 ms. Each Subnetwork cycle has an overhand of about >= 100 ms.

Since the plc cycle time is asynchronous with ABC cycle time the FB integrates a trigger
instead of checksum to the SN5 structure. When a master telegram is completed by the FB the
trigger will be incremented. The corresponding transaction will be updated by change of state
on trigger and exchanges the trigger with checksum byte before the SN5 telegram is send into
subnetwork.

The subnetwork reply is checked and checksum byte is exchanged with incremented trigger
byte before the telegram is send to plc by ABC. The FB will wait until a valid slave telegram is
responded before sending a new telegram. Due to it the minimum time between update cycle
amounts to >= 110 ms minimum. Please consider this for time critical applications!
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Hardware Configuration

2.2 Setup of PLC, PROFIBUS® and ABC

Create New SIMATIC® Manager Project

1. Start the SIMATIC® Manger and create a new project: "File" > "New".
2. Enter the project name “SIKO_example_S7300".

3. Choose a project path.
4

Execute the command “0K”.

2.2.1 Add Your PLC to the Project

1. Insert a new S$7-300 station by using the command
"Insert" > "Station" > "SIMATIC 300 Station"

.‘; SIMATIC Manager - SIKO_example_S7300
File Edit |Insert| PLC View Options Window Help

O =& | & Station ' 1 SIMATIC 400 Station [
Subnet | | 2SIMATIC 300 Station |
Program » 3 SIMATIC H Station
— 57 Software ) 4 SIMATIC PC Station —
E S7 Block 5 5 Other Station

5 6 SIMATIC 55
7T PG/PC

M7 Software

Symbol Table
Text Library 4
External Source...

The new station appears below the project name.

2. Open the hardware configuration tool with command "Edit" > "Open Object"

.‘; SIMATIC Manager - [SIKO_example_S7300 -- Di\test\SIKOY
&P File| | Edit|[Insert PLC View Options Window Help

0O = Cut Ctrl+X ||_
E% 2] Copy Ctrl+C  fmk
o Paste Ctrl+V

Delete Del
Select All Ctrl+A
Undo Selection
Rename F2
Object Properties... Alt+Return
Special Object Properties *
Open Object Ctrl+Alt+0

Check Block Consistency...
Compile Ctrl+B

Export Source...

|
Now an empty hardware configuration window is opened.
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Hardware Configuration

3. Choose "Rail" from the folder "RACK-300" of the hardware catalog on the right side. Use
drag and drop to move the "Rail" to the hardware configuration.
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4. Choose the CPU from the hardware catalog and plug it into slot 2 of the rail.

d L g

The Properties - PROFIBUS interface DP will open.

NOTICE

circumstances.

The Profibus Address in this example can cause problems under certain
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Hardware Configuration

5. Create a new Subnet "New..."

] P T—
6. Confirm the settings with "0K".
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7. Close the "Properties — PROFIBUS interface DP" window.

2.2.2 Register the GSD Device Description File for ABC

1. Install GSD for ABC via command "Options" > "Install GSD File..."
2. Browse to the storage location of the GSD file and choose the actual version.
3. Install the selected file.
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After installation the ABC is available in the hardware catalog.
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Hardware Configuration

2.2.3 Add New Module to Your Hardware Configuration

1. Choose "Anybus Communicator Slave" within the folder "Gateway" from the hardware
catalog and attach it to the PROFIBUS subnet using drag and drop.
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The Properties — PROFIBUS interface Anybus Communicator SI will open.

NOTICE The Profibus Address in this example can cause problems under certain
circumstances.

2. Enter a valid PROFIBUS® Address, “77” for example.
3. Confirm the settings with "0K".
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Hardware Configuration

2.2.4

SIKO AGO5

Configure the Data Input / Output of ABC

1. Add "IN/OUT 4 Bytes (2 word)" from device “Anybus Communicator Slave” of the hardware

catalog to the “Devices overview”.

catalog to the “Devices overview”.

S ErowC sl

T

Add "Universal module" from device “Anybus Communicator Slave” of the hardware
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3. Double click on “Universal module” to open “Properties DP slave”.
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Setup the “I/0 type” to “Out - input”.
Choose the next “Address” after "IN/OUT 4 Bytes (2 word)".
Modify the “Length” to “10” of “Unit” “Byte”.
Select for “Consistent over” “Total length”.
4. Confirm the settings with "0K".
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Hardware Configuration

5. For each SN5 device a “Universal module” is required.
Select the before modified “Universal Module”. Copy “Ctrl + C” and Paste “Ctrl + V" it to
the required amount.
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6. Save and compile the hardware configuration.
7. Close "HW Config".

The hardware configuration of the project is now complete.
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Software Configuration

3 Software Configuration

3.1 Import the SIKO-Library

Execute command "File" > "Retrieve".

1

2. Browse to the storage location of the SIKO-library.
3. Select the archive SIKO_SN5-PBvABC_LIB_V501.zip.
4

Execute the command “Open”.

I TT ™

Hame Andeungsteam Ty
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Detstyor [PZ0 12 4 eteve " 2 j Atrecher

5. Select a destination directory accordingly and open it.

3.1.1 Integrate the Symbole from the Library to Project

Navigate to the tab “S7 Program(1)” in the project tree

Double-click on the object “Symbole” in the right window

VAT Wanaget | (SN0 _sasmpie 7200 . [ beer SN0 AR ek
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w

In the Symbole Editor execute command "Symbole" > "open".
Select the library SIKO_SN5-PBvABC_LIB_V501 and “SIKO_FB”.

Choose “Symbole” and confirm your selection with “OK”".

ooR
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Software Configuration

e
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6. Execute command "Window" > "Arange" > “Vertically”.
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7. Select ALL by the keystroke combination [Ctrl] + [A].
8. Copying it into the clipboard with the keystroke combination [Ctrl] + [C].

9. Click into line 2 (emty one) of your project symbole table and enter with the keystroke
combination [Ctrl] + [V].

10. Delete the the red marked line.
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11. Close symbole table “SIKO_FB".

12. Save and close your project symbole table.




Software Configuration

3.2 Add Required Function Blocks

Add 0B82, 0B86 and 0B122 to the folder "Blocks".
1. Select folder "Blocks".

2. Execute command "Insert" > "S7 Block" > "1 Organization Block".

O
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' Emn | Symechc name i
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3. Enter organization block name "0B82".
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4. Repeat steps 2 and 3 with block name "0B86" and "0B122".

3.3 Call SIKO Function Block Cyclically

1. Double click on "0B1".
2. Add function block FB205 from library to main program.
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3. Enter the name "DB205" for instance data block.

4. Confirm the message window / selection with "Yes", so the instance DB205 is generated.
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Software Configuration

3.3.1 Setup the Input and Output Addresses of the SIKO Function Block

To setup the input and output addresses of the function block the decimal address values from
the hardware configuration have to be converted to hexadecimal values.
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A L T OerQ 8- ve wrindah L OREYY ik L2108
[ 1 [Fo s o :

| »o e @ (e

In this example the conversion table looks like this:

Slot 2 - Q address 260...269dec DC_StartByteOut W#16#104

Slot 2 - T address 260...269dec DC_StartByteln WH16#104

The input "nNodeId" of the function block must be connected with the set note address of
the SN5 device.

In this example the address B#16#5 (5dec) is used.

After set up of the addresses save the settings and close the editior window and confirm "0K".
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Software Configuration

3.4 Insert Variable Table for Testing
1. While your project is still open execute command “File” > "open"
2. Select the library SIKO_SN5-PBvABC_LIB_V501
3. Execute command "Window" > "Arange" > “Vertically”.
4. Choose “VAT_SIKO_AGO05” and copy it into your project using drag and drop.
—— S|
.un"”_?&zg:ﬁv Leasmw
= . 3 SN
'“g’i»_”;«’ e 3 =
g  mmamn © -
|

5. Close library “SIKO_SN5-PBvABC_LIB_V501".

3.5 Complete the Project

1. Select folder "Blocks".
2. Click into the right window and select ALL by the keystroke combination [Ctrl] + [A].

3. Execute the command “Download”.

&m@mmmmmumm,'

D@ = xms-lzlw%-.:a.lm!ewm l %O!Em\?
B8P SN0 _exarple 57300 i
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e-fl crunac2or : Q Trgwsewion B
B30 57 ProganiS) 0 an : B Thgwiasan Bix

%?E‘:‘ AACH_FLT 5 B Orpesentai Fl
Wiz MOD. ERA . N Orgussaton ke

4. Confirm the following message boxes with “Yes” or “OK” respectively.
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Software Configuration

oo =)

3.6 Work with the Project
1. Double-click on “VAT_SIKO_AGO5".
2. Enable the “Monitor” option in the VAT window.
3. Now you can control the SIKO-AGO5 by setting the control bits.
&ﬁ War - [VAT_SIKO_AGOS -- @SIKO_example_S73000SIMATIC 300(1)0CPU 313C-2 DPVST Programi5) OMLIME]
ﬁ Table Edit Insert PLC Variable View Options Window Help
= Dlzla| 8| #|mle[o]«| x|[E 2] x| 65| s
Q Address Symbol Statug value | Modify value
1_ DB205.DBW 0O "SIKO_DRV_AGOSvPBE-DATA" DC_StartByteCOut 260
2 DB205DBW 2 "SIKO_DRV_AGOSvPB-DATA" DC_StartBytein 260
3
4 DB205DBB 8 "SIKO_DRV_AGOSvPE-DATA" vnNodeld 5
5 DB205.DBD 4 "SIK0_DRV_AGOSvPE-DATA  vnSetValue L#0
i} DBZ205.DBD 14 “SIKO_DRV_AGOSvPE-DATA  vnActualvalue L#2159
T DB205.DBE 28 "SIKO_DRV_AGOSvPB-DATA" p00_NodeAddress_r B#16:01
3 DB205.DBE 25 "SIKO_DRV_AGOSvPE-DATA" p00_NodeAddress w B#16:#01
9
10 DB205.DBB 11 “SIKO_DRV_AGOSvPB-DATA" vnParameteradrRead
11 DB205.0DBB 12 “SIKO_DRV_AGOSvPE-DATA" vnParameteradrRead2
12| DB205.DBB 13 "SIKO0_DRV_AGOSvPE-DATA" vnParameteradrReads
13| DB205.DBX 10.2 | "SIKO_DRV_AGOSvPB-DATA” bcStartRead
14 DB205.0BX 10.3 | "SIKO_DRV_AGOSvPB-DATA" bcStartWrite
15 DB205.DBX 10.4 | "SIKO_DRW_AGOSvPB-DATA" beStartCopy
18 DB205.DBX 10.5 | "SIKO_DRV_AGOSvPB-DATA" boResetCounterActivity
17 DB205.DBW 240 : "SIKO_DRV_AGOSvPB-DATA" vnCounterRead
18 DB205.DBW 242 | "SIKO_DRV_AGOSvPB-DATAM vnCounterrite
18| DB205.DBW 244 | "SIKO_DRV_AGOSvPB-DATA" vnCounterCopy
20 DB205.DBE 21 “SIKO_DRV_AGOSvPE-DATA" vnErrorCode
| DB205.DBB 22 "SIKO_DRV_AGOSvPB-DATA" vnErrorCode2
22 DB205.DBX 18.5 | "SIKO_DRV_AGOSvPB-DATA" bsDone
23 DB205.DBX 18.6 | "SIKO_DRV_AGOS5vPB-DATA" bsBusy
24 DB205.DBX 189.7 : "SIKO_DRV_AGOSvPB-DATA” baFaultDataReceive
25 DB205.DBX 20.0 ; "SIKO_DRV_AGOSvPB-DATA™ beComTimeout
26| DB205.DBX 201 | "SIKO_DRV_AGOSvPB-DATA™ beGeneralError
27| Ji Control Bits ====
28 DB205.0BX 9.0 | "SIKO_DRV_AGOSvPB-DATA" bcO0_OFF1Enable
25 DB205.DBX 9.1 | "SIKO_DRW_AGOSvPB-DATA" bo01_OFF2MaxDeceleration
30 DB205DBX 9.2 | "SIKO_DRV_AGOSvPB-DATA" bc02_OFF3ProgDecelsratio
H DB205.DBX 9.3 | "SIKO_DRV_AGOSvPB-DATA" be03_IntermediateStop
32 DB205.DBX 9.4 ; "SIKO_DRV_AGOSvPB-DATAbcO4_ StartTravellob
33 DB205.DBX 9.5 | "SIKO_DRV_AGOSvPB-DATAbclS_ErrerAcknowledgment
34| DB205.DBX 8.8 | "SIKO_DRV_AGOSvPB-DATA™bcOS InchingMoedel
35 DB205.0DBX 9.7 | "SIKO_DRV_AGOSvPB-DATA" bc07_Inching2Pos
35 DB205.DBX 10.0 | "SIKO_DRW_AGOSvPB-DATA" bc08_Inching2Neg
37 DB205.DBX 101 | "SIKO_DRV_AGOSvPB-DATA" bc0S_KevEnable
38 Ji Status Bits
39 DB205.DBX 18.0 ; "SIKO_DRV_AGOSvPB-DATA™ bs00_Supphy
40 DB205.DBX 18.1 | "SIKO_DRV_AGOSvPB-DATA™ be01_ReadinessToTravel
41 NRZNS NARY 18 7 ! "IKN NRY AGRNSYPRNATA™ heN? |innerl imit
SIKO_example_S73000SIMATIC 200(1)%..\57 Pregram(5) Abs < 5.2

m
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Communication Settings

4.1

4.2

4.2.1

4.2.2

4.2.3

4.3

SIKO  AGOS

Communication Settings

Data Exchange

The FB is designed to send or receive in alternation the “nSetValue” (Write, Parameter:
OxFF “Set Point ”) or the “nActualValue” (Read, Parameter: OxFE “Actual Position”)
respectively, while no specific parameter access is active.

With the “nParameterAdrRead1”, “nParameterAdrRead2” and “nParameterAdrRead3” further
parameter can be included in the data read cycle. With default value OxFE the inclution is
disabled.

NOTE: If “bsFaultDataReceive” is indicated the complete data exchange is stopped, while
Control and Status Word are still updated! A missing or not responsing subnetwork participant
is indicated by “bsComTimeout” (0,5sec. + time set in parameter 0x02 Bus Timeout).

Parameter Access

The present module contains the parameter data in addition to the process data (CW/SW).
Parameters that can be changed (read/write) exist in programming as actual value (_r) and as
target value (_w) as well. Furthermore, it is differentiated between pure read parameters (only
indicated as actual value) and pure write parameters (only indicated as target value).

A rising edge must be applied either to the “bcStartRead” or to the “bcStartWrite” input on
the module described here in order to enable a read or write process of one of the variables.

Read Parameters
If a rising edge is applied to the "bcStartRead” input, then all parameters will be read and can

be used for further programming. If counter read value is not reset to “0” the read cycle was
interrupted by read failure. This indicates to a communication failure.

Write Parameters
If a rising edge is applied to the “bcStartWrite” input of the module, then all parameters will
be transferred to the module. If counter write value is not reset to “0” the write cycle was

interrupted by a write failure. This indicates to a communication failure or parameter value is
beyond range of value accepted by AGO5.

Copy Parameters from Read to Write

If a rising edge is applied to the “bcStartCopy” input of the module, then all actual values
(_r) are copied to their corresponding target values (_w).

S-Commands

After executing a S-Command a read cycle is been triggered to refresh all actual values (_r).

Date: 20.04.2016 Mod. Status V1.0.0 Page 20 of 25



4.4

SIKO  AGOS

Communication Settings

Counter Value

Count | Count | Name Value range (dec) Default
read write
value | value
1 0xA8 Programming Mode On/Off 0...1 0
1 2 0x00 Note address 0...31 1
2 3 0x01 Baud rate 0...2 1
3 4 0x02 Bus Timeout 0...20 20
4 5 0x03 Response parameter to a 0...8 1
setpoint write access
5 6 0x04 Keys enable time 1...60 3
6 7 0x05 Key function enable 0...1 0
7 8 0x07 LED 2 orange 0...1 1
8 9 0x08 LED 1 red 0...1 1
9 10 0x09 LED 1 green 0...1 1
10 11 0x0A Decimal places 0...4 0
11 12 0x0B Display divisor 0...3 0
12 13 0x0C Direction indication function 0...2 0
13 14 0x0D Display orientation 0...1 0
14 15 0xOE Programming mode 0...1 0
Configuration
15 16 0xOF PIN change 0...99999 0
16 17 0x10 Controller parameter P 1...500 300
17 18 0x11 Controller parameter I 0...500 2
18 19 0x12 Controller parameter D 0...500 0
19 20 0x13 a - Pos 1...100 50
20 21 Gear 10
66:1=>1...75
0x14 v - Pos 98:1=>1...50
21 22 0x15 a - rot 1...100 50
22 23 0x16 a - inch 1...100 50
23 24 Gear 10
66:1=>1...75
0x17 v - inch 98:1=>1...50
24 25 0x18 i - Numerator 1... 10000 1
25 26 0x19 {i - Denominator 1...10000 1
26 0x1A Encoder resolution 720
27 27 0x1B Sense of rotation 0...1 0
28 28 0x1C Spindle pitch 0 ... 1000000 0
29 29 0x1E Offset -999999 ... 999999 0
30 30 0x1F Calibration value -999999 ... 999999 0
31 31 0x20 Pos- window 0...1000 10
32 32 0x21 Pos type 0..2 0
33 33 0x22 Loop length 0 ... 30000 360

Date: 20.04.2016

Mod. Status V1.0.0

Page 21 of 25




Communication Settings

Count | Count | Name Value range (dec) Default
read write
value | value
34 34 0x23 Inpos mode 0..2 0
35 35 0x24 Delta Inch -1000000 ... 1000000 | 720
36 36 0x25 Acceleration type with Inching | 0 ... 1 0
mode 2
37 37 0x26 Inching 2 Offset 10 ... 100 100
38 38 0x27 Stop mode inching 2 0..1 0
39 39 0x28 Operating mode 0...1 0
40 40 0x29 Limit 1 -9999999 ... 9999999 | 99999
41 41 0x2A Limit 2 -9999999 ... 9999999 | -19999
42 42 0x2C Current limiting 25 ... 110 110
43 43 0x2D Contouring error limit 1...30000 400
44 44 0x30 Display value of 2nd line 0...7 0
45 45 0x33 Display divisor application 0...1 0
46 0x60 Output stage temperature 0
47 0x61 Voltage of control 0
48 0x62 Voltage of output stage 0
49 0x63 Voltage of battery 0
50 0x64 Motor current 0
51 0x65 Device code 0
52 0x66 Display controller software 0
version
53 0x67 Motor controller software 0
version
54 0x68 Serial number 0
55 0x69 Production date 0
56 0x6A Gear reduction 0
57 0x6B Actual position 0
58 0x6C Actual rotational speed 0
59 0x80 Number of errors 0
60 0x81 Error 1 0
61 0x82 Error 2 0
62 0x83 Error 3 0
63 0x84 Error 4 0
64 0x85 Error 5 0
65 0x86 Error 6 0
66 0x87 Error 7 0
67 0x88 Error 8 0
68 0x89 Error 9 0
69 0x8A Error 10 0
46 OxAA FreezeAV 0...1 0
70 OxFA System status word 0
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Communication Settings

4.4.1

SIKO  AGOS

Count | Count | Name Value range (dec) Default
read write
value | value
71 OxFE Actual value 0
72 OxFF Set point 0
47 0xA0 System Command 1...9 0

Error Codes

If a communication error occurs, there is an error code present at the outputs “nErrorCodel

"

and “nErrorCode2”. Please refer to the AGO5 manual (keyword: error codes) for a complete
description of these error codes.
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Additional Information

5

5.1

5.2

5.3

SIKO  AGOS

Additional Information

Corresponding Node Address

Since the different SN5 devices can be commanded to change the actual used node address,
make sure, that before a “bcStartWrite” is executed, “vnNodeld” (temporary address) and
“p00_NodeAddress_w” (set address) are adjusted accordingly.

Otherwise a lost of communication after cold start or software reset is possible!

Priority of “bcStartRead”, “bcStartWrite”, “bcStartCopy” or “bcResetCounterActivity”

If one of “bcStartRead”, “bcStartWrite”, “bcStartCopy” is high/true the others are blocked,
except “bcResetCounterActivity”. The priority is: “bcStartRead”, “bcStartWrite”, “bcStartCopy”.

There is no timing or device condition to execute either “bcStartRead” or “bcStartCopy”. For
execute “bcStartWrite” the device must be without movement and “vnCounterRead” and
“vnCounterCopy” are inactive.

Otherwise “bcStartWrite” is not executed or delayed!

If “bcResetCounterActivity” is high/true ALL counters are set to “0” as well as the internal
status of “bcStartRead”, “bcStartWrite”, “bcStartCopy”.

Difference in SN5 Protocol Between PLC <-> ABC and ABC <-> SN5 device

The FB is creating a protocol string according to the device manual but with one network
required modification, which is a trigger byte instead of checksum byte at the protocol end.

This is required since the plc cycle and update time is much higher than from the ABC. Every
time the FB has completed the string, it increases the trigger value by one. The ABC
configuration is designed to check this plc trigger. Every time the ABC application update
cycle comes together with the plc trigger change, the ABC configuration exchanges the
trigger byte with a checksum byte and sends the SN5 protocol into the subnet.

The addressed SN5 slave replies with a respectively protocol and the ABC performs the
checksum test. If positively checked, the ABC exchanges the checksum byte with a trigger
byte and transfers the protocol string to the master plc. This trigger is monitored (fix 500 ms)
and used together with “p02_BusTimeout_r” to create “bsComTimeout”.

The protocol string with trigger byte recived from and transmitted to plc can be viewed in the
ABC “Node Monitor”. Go online with ABC while application runs. Click the node underneath
“Subnet”. Then start the “Node Monitor” which should be selectable now:

I Sl Anybus Canfiguration Manager - Communicator RS232/422/485 - Untitle

Eile 5IKO Tools View Help

nEELD X
Devices: Configuration:

B2 Fieldbus dlphabetic Categorized |
------ Communicator RS 232/422/485

H General
Slave addresz 1

- Transactions 1
-] Transactions 2
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Additional Information

You should have similar few:

In Area 204 bptes [512) ér/ Out Area 204 bytes [512) %f/ General duea O bytes
OODOMINENZZNZE [ C© FE 1| || 0zO0 o EIL_E_%]F 0 .|/ 0400
ooog 3 0 0 1 F4[11]1 1 & 0208 7 0 0 0 0 1 & 0408
D10 FE 1 3 0 0 25811 DZI0FF 0 7 0 0 0 & gd 0410
0018 0 0 0 0 0 0 0 0 D212 0 0 0O 0 0 0 0 O g4is
D020 0 0 0 0 0 0 0 0 D220 0 0 0 0O 0 0 0 0 0420
o2 0 0 0 0 0 0 0 O D222 0 0 0O 0 0 0 0 O g4ze
030 0 0 0 0 0 0 0 0 D230 0 0 0 0 0 0 0 0 0430
038 000 0 0 0 0 00 0238 0.0 0 0 0 0 00 0438
In the “Out Area ...” you can see what is send from plc. In this example the ID5 is requested

for current position.

In the “In Area ..."” you can see what comes from subnet. In this example the ID5 replies
current position (1F4 (h) = 500 (d)).

To the ID 6 the target position (258 (h) = 600 (d)) is send and confirmed.

Please keep in mind, that the 10" Byte is not checksum but trigger value!
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